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Introduction
Designed for government, military, security, surveillance and industrial applications,
WiNRADiO Spectrum Monitor puts advanced radio receiver technology directly on a
personal computer platform to create a high-performance PC-based spectrum surveillance
and monitoring system.

This synergy of advanced radio and computing technology provides the WiNRADiO
Spectrum Monitor with many unique features which are hard to find on the usual stand-alone
communications radio receiver. These features include a rich variety of flexible tuning and
scanning options, versatile memory and database facilities, the ability to digitally process the
received signal, as well as the ability to interact with other programs running on the same
PC. All this is controlled through an innovative user interface, unparalleled in sophistication
and ease of use.

The internal version (WR-3700i-DSP) conserves valuable desk-top space, and avoid the
need for external cables and power supplies. It also have the advantage of not requiring any
additional interface ports, as all communication with the PC is via the internal PC bus. A
dedicated DSP (Digital Signal Processor) is used for real-time audio compression and
playback, and can be expanded to include other real-time signal processing functions tailored
to the user's particular requirements. Multi-channel operation is simple to achieve, as up to
eight WiNRADiO internal receivers can be used simultaneously in the one PC.

The external version (WR-3700e) can be controlled through an RS-232 serial interface, or
the optional plug-and-play PCMCIA interface. The PCMCIA interface allows quick and
simple connection to any laptop PC, providing complete portability for vehicle or field use.
The external versions can be powered by the plug-pack (supplied), or from the optional WR-
PPS battery pack with inbuilt charger. The external model also include a direct discriminator
output, for optimum reception of packet and other digitally modulated signals.

The informative control panel displayed by the WiNRADiO Spectrum Monitor includes a
number of ground-breaking features, designed to empower the user with a multitude of
tuning and scanning capabilities especially tailored for surveillance applications. One of the
most significant features is VisiTune™, a patented feature allowing the operator to
graphically tune within a dynamically-changing spectrum screen representing the actual
situation on the monitored band.

Add to this the fact that WiNRADiO Spectrum Monitor features an automatic task scheduler
which can be programmed for unsupervised operation, search for specific types of signals
and even make decisions based on the specified circumstances, and you will find that
WiNRADiO Spectrum Monitor represents an invaluable tool, making radio surveillance
easier and much more efficient and reliable.

Registration Information

To be informed about any new products or software upgrades, please register using the Web
site closest to your location:

North America www.winradio.com/home/register.htm

Europewww.winradio.co.uk/home/register.htm

Australia/Asia www.winradio.net.au/home/register.htm

Comments and suggestions are welcome, and can also be made from these sites.

Be sure to visit out Web site from time to time, and watch for new software upgrades and
options as they become available.
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Installation
The WiNRADiO internal version package contains the following items:

• WiNRADiO receiver card

The WiNRADiO external version package contains the following items:

• WiNRADiO receiver unit

• RS-232 cable

• Power adaptor

• PC Card Adaptor option (if ordered)

• Portable Power Source option (if ordered)

Both packages include the following items:

• WiNRADiO software installation disk

• Indoor test antenna

• This User’s Guide

• The manufacturer’s warranty information

• Any software option (such as the WiNRADiO Digital Suite or Database Manager), if
ordered

Note that you must supply your own antenna for optimum reception.

In order for your WiNRADiO receiver to function, your IBM PC compatible computer must
meet the minimum system requirements specified below.

System Requirements

Minimum Recommended

Processor: 386 Pentium or higher

RAM: 4 MB 16 MB or more

Display VGA SVGA: at least 800x600, 256 colours

OS: Windows 3.1 Windows 95, 98 or NT 4

Spare serial port or PCMCIA socket for the external model, or a spare ISA slot for the
internal model.

3700i Hardware Installation

1. If your computer is on, shut down the computer first, turn it off and disconnect the
power cord.

2. Remove the computer cover.

3. If other expansion cards are fitted, check their address assignments. If necessary, change
any of the jumpers on the WiNRADiO receiver card to avoid conflicts. (The default I/O
port 180, IRQ 10 and DMA 0 should normally work, however if you need to change any
jumpers, see the following section about ‘Jumper Settings’.)

4. Choose an empty 16-bit expansion slot, preferably with an empty slot immediately to
the right (assuming you are facing the computer front).

5. Important: Before inserting the WiNRADiO card, touch the computer metalwork with
your hand (to drain any static charge from your body), and also touch the metal bracket
on the WiNRADiO card.
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6. Carefully insert the card into the vacant slot, and push until it is firmly seated. Screw the
metal bracket at the end of the card to the computer case (this must be done to minimise
ground-conducted interference).

7. Replace the computer case and reconnect the power cord.

8. Plug a speaker or headphones into the audio jack at the rear of the card. Alternatively, if
you have a sound card and wish to route WiNRADiO through it, you can plug an audio
‘patch’ cable from the audio jack to the ‘Line In’ jack on your sound card. Note that a
3.5mm stereo plug must be used, otherwise you will hear no audio from the receiver. A
suitable patch cable is included with the WiNRADiO Digital Suite option.

9. Connect the antenna to the BNC jack at the rear of the card and extend the antenna up
and as far away from the computer as possible.

10. If you have a plug-and-play computer, you may have to configure the BIOS under
'PNP/PCI CONFIGURATION' to set the appropriate IRQ and DMA to 'Legacy ISA'
instead of 'PCI/ISA PnP' to avoid conflicts with any plug-and-play devices in your
computer. You should also make sure that any PCI IRQs are not the same as
WiNRADiO's.

Jumper Settings

The WiNRADiO receiver card is provided with jumpers which select the desired I/O port
address. The jumper may need to be changed from the factory default settings to avoid
conflicts with other cards already installed in the computer.

There are eight possible I/O addresses which the WiNRADiO card can use: 180, 188, 190,
198, 1A0, 1A8, 1B0 and 1B8 (all specified in hexadecimal). There are also 8 different IRQs:
3, 5, 7, 9, 10, 11, 12 and 15, and 2 DMA channels: 0 and 3. The factory default is I/O port
180, IRQ 12 and DMA 0.

If more than one WiNRADiO card is to be installed in the computer (up to 8 depending on
available address lines), each card must be assigned a unique I/O address and IRQ. The
DMA channels can be shared, all eight are able to run on one DMA channel, but it is
recommended to evenly distribute the card’s DMA settings across the two channels if
possible.

Some of the WiNRADiO IRQs can be used by other devices, for example: IRQ 3 is normally
used for COM2, 5 for a sound card, 7 for an EPP or ECP printer port, 9 for a video card, 10
for a network card, 11 for a SCSI card, 12 for a PS/2 mouse port and 15 for the secondary
IDE port. If you wish to use any of these interrupts, make sure that either these devices don’t
exist, or disable them. 
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3700e Hardware Installation

1. First install the software (see below).

2. Connect the supplied power adaptor to the +12V DC power socket on the rear of the
unit, and switch the unit on.

3. Connect the supplied RS-232 (or optional PC Card Adaptor) cable between the
computer and the WiNRADiO unit.

4. Connect the antenna to the BNC connector at the rear of the unit, and extend the antenna
up and as far away as possible.

Software Installation

1. Insert the WiNRADiO installation disk into your floppy drive.

2. If you are using Windows 95, 98 or NT 4, click on the ‘Run’ command in the ‘Start’
menu. If you are using Windows 3.1x or NT 3.5x, Click on the ‘Run’ command in the
‘File’ menu in Program Manager or File Manager.

3. Type A:\INSTALL (or B:\INSTALL if your floppy drive is B).

4. After the Welcome dialog box and Licence agreement, you will be prompted to enter a
directory to install the WiNRADiO software. You can either choose to accept the
default, or you may enter your own.

5. The installation will then proceed to install the necessary files onto your hard disk. You
will then be asked whether you want to add an icon to Windows. If you accept, you will
then be asked which program group to add the icon to.

6. If this is the first installation in Windows 3.1x, 95 or 98, you will then be asked to
restart Windows. The WiNRADiO receiver will not work until Windows has been
restarted. In Windows NT, a hardware configuration utility will pop up allowing you to
specify the hardware settings for the software (see the next section ‘I/O Configuration’
for more details).

WiNRADiO software is periodically upgraded. Check out the newest software version on our
Web site at www.winradio.com. If you wish to be automatically notified of upgrades and
other WiNRADiO related information, please register with our user database by sending an
e-mail message with subject heading REGISTER to support@winradio.com.
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I/O Configuration

To inform the software of the hardware configuration, a Control
Panel applet is used. Open Control Panel and double-click on the
WiNRADiO icon. A dialog box will appear, which allows you to
specify the hardware configuration for the software.

Windows 3.1, 95 and 98

As can be seen, up to 8 internal cards can be configured, and for
each card installed, a suitable I/O address must be nominated.

In most situations, you can use the ‘Auto Detect’ feature, which will allow the software to
find all the internal cards and the IRQ and DMA settings for each. Only rare circumstances
stop the auto-detection from working.

If there are any problems with the settings (such as an address conflict), you will be notified
of the problem.

After you click on OK and any setting has been changed, you will be prompted to restart
Windows for the new settings to take effect.

Windows NT

Up to 9 receivers (internal and external) can be configured,
and for each receiver installed, its location must be
nominated.

In most situations you can use the ‘Auto Detect’ feature,
which will allow the software to find all internal I/O ports,
serial ports (must be switched on) and PC Card slots a
receiver is connected to. Note it will not detect the IRQ or
DMA settings for the internal receivers but will detect the
presence of the DSP.

An optional fifth field is provided that allows you to specify a name to be associated with the
receiver. The name will appear in the title of the main window instead of the traditional
‘WiNRADiO Spectrum Monitor #’ title.

After you click on OK, the new settings take immediate effect.

Uninstalling WiNRADiO

In Windows 95, 98 and NT 4, start up Control Panel and double-click on the ‘Add/Remove
Programs’ icon. Select ‘WiNRADiO’ from the list and click on the ‘Add/Remove’ button.

In Windows 3.1x and NT 3.5x, double-click on the ‘Uninstall WiNRADiO’ icon in the
program group that contains the WiNRADiO icon.

All software and changes to any configuration files will be removed from your hard disk.
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Troubleshooting

Installation Problems

If you try to start-up your WiNRADiO receiver for the first time and you are presented with
a dialog box stating that the WiNRADiO receiver card could not be found, you most likely
have a configuration problem.

If you are using an internal WiNRADiO model, open the WiNRADiO configuration utility
from Control Panel by double-clicking on it. Click on ‘Auto Detect’. If no WiNRADiO card
can be found, then you probably have a hardware address conflict. Shut down the computer,
and try other jumper settings as described earlier in this chapter. Start up the computer and
try auto-detecting again.

If you are using an external WiNRADiO model, make sure it is plugged in and the power is
turned on (the red LED on the front panel should be illuminated).

If you are using the WiNRADiO software and find that the Spectrum Scope is obscuring the
panel, try to reposition the main WiNRADiO control panel window by changing it from full-
screen to a window, and positioning it in the top area of the screen. Shrink the size vertically
so there is a thin border around the panel. This should make your WiNRADiO receiver
easier to use.

If you are finding that shortcut keys are not responding (including the tab and cursor keys),
try clicking on the appropriate window with the mouse to activate the window. If you have
more than one dialog box open at the same time, try closing them until only one is left open.

Sensitivity Problems

The WiNRADiO receiver is very sensitive, so low sensitivity problems are usually due to
noise induced into the antenna by the PC monitor, less commonly the PC, or some other
external source. If the noise is strong enough, it can overload the receiver which responds by
automatically reducing sensitivity using its AGC (Automatic Gain Control) mechanism. This
problem is more common on low frequencies (under 30MHz). As a result, the reception can
become noisy and the receiver appears to be ‘deaf’.

This can happen if the antenna is poorly located, for instance if it is too close to the PC
monitor, or used inside a building with steel-reinforced concrete walls. Try repositioning the
antenna, or placing ferrite cores over its shielded lead close to the receiver, to break the
transmission of interference back to the antenna.

Another remedy which is often effective is to place an RF (radio frequency) filter between
the PC mains lead and the wall power outlet, to reduce interference caused by earth loops.

If these measures fail to produce the desired noise reduction , and if you are using an internal
receiver model, try moving the receiver card to a different slot inside the PC, as far as
possible from other potentially noisy cards, especially the video card, and the power supply.

Video monitors are also major sources of interference, and there are significant differences
between brands in this respect. You can establish the noise contribution of your monitor by
switching it off. If the noise diminishes substantially, check that the monitor lead is fitted
with a ferrite suppressor bead (the rectangular or cylindrical moulding on the lead). If not, fit
a suppressor, or acquire a quieter monitor.
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Intermodulation Problems

Your WiNRADiO receiver has been designed to be very sensitive in order for it to work
with the moderately small antennas which are preferable for VHF/UHF. In areas with strong
local broadcast stations, the WiNRADiO receiver front-end may overload and, as a result,
intermodulation products may appear in the received band. By pressing the Local button on
the control panel, the interference products will disappear.

It is advisable to use the Local setting if you are operating the receiver with larger outdoor
antennas, especially on broadcast bands. For long-distance shortwave reception, a
considerable improvement can be obtained by using a tuned antenna and preselector.
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Using WiNRADiO
When you first start WiNRADiO, you are presented with a radio receiver interface. The
image below shows the main parts of the control panel.

The following few sections document each of the parts in detail.

Basic Controls

Frequency Readout

The frequency readout shows the current receiver frequency.

Below this is another display which shows one of the following:
the callsign and/or a comment relating to the current tuned
frequency, taken from the frequency memory (entered by the user), or the description of the
current band. The band description is user-definable under ‘Auto-stepping’ in the Configure
menu.

To enter a frequency, simply type the desired frequency using the keyboard. As soon as you
press a number or the decimal point, the frequency readout will enter the edit mode, allowing
you to enter the frequency. The old frequency is automatically overwritten. If you want to
edit the existing frequency, click on the readout with the left mouse button to highlight the
current frequency, position the cursor as desired, reclick the left mouse button, make the
desired changes, then press the Enter key. To change the frequency unit (kHz, MHz or GHz),
press K, M or G respectively while the display is highlighted or in edit mode.

To tune the receiver to the new frequency, press the Enter key. To cancel and return the
previous display, press the Escape key.

In each mode, the frequency readout only displays the most significant digits which affect
tuning and reception. The display resolution is as follows: 1 Hz in CW, LSB and USB, 10
Hz in FMN, 100 Hz in AM and 1 kHz in FMW.

In FMW, the lowest tunable frequency is 30 MHz. If you attempt to tune to a frequency
below 30 MHz, the receiver will automatically change the mode to AM, and disable the
FMW button.

Tuning Knob

The tuning knob adjusts the frequency by the smallest suitable increment for
the current mode. In LSB, USB and CW it is 10 Hz; AM is 100 Hz; FMN is
500 Hz, and FMW is 50 kHz.

To use the knob, position the mouse cursor over the top half of the knob, and
the cursor will look like this:       . To decrease the frequency, click the left
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mouse button. To increase the frequency, click the right mouse button. On the bottom half,
the cursor will flip vertically        . The mouse buttons will now operate in reverse, with the
left increasing and the right decreasing the frequency.

To tune the receiver from the keyboard, press the up/down cursor keys to increase and
decrease the frequency respectively.

For faster tuning, use the Shift or Ctrl keys simultaneously with the mouse or keyboard
tuning commands to multiply the frequency step by 10 or 100 times respectively.

To reduce the step size to 1 Hz for more accurate tuning of LSB, USB or CW, use the Alt
key simultaneously with the mouse or keyboard tuning commands.

Modes

WiNRADiO WR-3700 series supports eight different reception modes (CW, LSB, USB,
AM, FMN, FMN2, FMN3 and FMW).

These modes are abbreviations of Continuous Wave (CW), Lower Side
Band (LSB), Upper Side Band (USB), Amplitude Modulation (AM),
Frequency Modulation Narrow-band (FN) and FM Wide-band (FW). FN1
bandwidth is 6.5kHz,FN2 15kHz and FN3 is 50 kHz.

To select the desired mode, click on the appropriate mode button or use the
keyboard shortcuts: A for AM, W for FMW, N for FMN, C for CW, L for LSB, and U for
USB.

Volume

The volume control is located on the right hand side of the panel. The volume
can range from 0 (no sound) to 31 (full volume).

There are several ways to adjust the volume. Using the mouse, you can increase
or decrease it by clicking on the up/down volume control arrows respectively, or you can
click on the scroll button between the two arrows and drag the volume up or down.

Using the keyboard, you can press V and enter the volume, or you can use the left and right
cursor keys to decrease and increase the volume respectively.

Signal Level Meter

The signal level meter, located under the volume control, shows the received
signal strength. It represents the strength by a bar graph, and shows the
equivalent numerical strength on the right side of the display.

The value represents the approximate signal level in dB above the receiver noise floor.

The signal level is also used to control squelch and scanning.

Squelch

The squelch controls the audio output and scanner threshold.

In normal operation, if the signal level drops below the squelch threshold, the audio output is
muted after a time delay specified under ‘Configure - General Options’. If the signal rises
above the squelch threshold, the audio is restored immediately.

The squelch indicator, at the bottom of the panel, shows whether the current signal level is
above or below the squelch threshold. If it is above the threshold, the display is green,
otherwise it is red.

The squelch threshold also controls scanning. When scanning, the receiver will pause or stop
if it receives a signal above the squelch threshold, otherwise it will continue scanning until
such a signal is found.
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If you wish, you can have different squelch thresholds for normal reception and scanning. To
activate this feature, go to Configure - General Options and select Separate squelch for
scanning. The receiver will then accept different squelch thresholds on the front panel, and
in the ‘Scanner - Setup’ dialog box (described later).

Attenuator

The attenuator controls the level of the RF signal entering the receiver front-end. If
a signal is too strong, it may overload the receiver and cause distortion. To combat
this problem, the RF signal can be attenuated by 18 dB by clicking on the Local
button or by pressing the O key.

If the attenuator is active and the signals are too weak, click the DX button or press
the D key to turn the attenuator off.

Stepping

Four stepping modes are available: fixed, auto, memory, and duplex. To select
between fixed, auto and memory stepping, click on the Select button or press the T
key until the desired stepping mode appears. Duplex stepping is activated
separately, as described below.

To step through frequencies, click on the up/down buttons located next to the
frequency readout, or press the Page Up/Page Down keys to step up/down
respectively.

The stepping modes are described below in more detail.

Fixed Stepping

Where stations operate on fixed channels (e.g. AM or FM broadcast band, mobile radio,
CB), it is usually more convenient to change the frequency in steps corresponding to the
channel separation.

You can specify the desired step size for each mode from a minimum equal to the frequency
resolution of the display, up to a maximum of 10 MHz. To enter the step size, either click on
the step display with the mouse, or press the F key; then enter the desired step size and press
Enter (or Escape to cancel the entry). Note that LSB/USB share the same step size.

If you change the mode, the step size will be changed to the size previously entered for that
mode.

Note that all modes retain the frequency to the nearest 1 Hz even though the extra digits
might not be visible. For example if you change from LSB to FMW and back, the actual
frequency is not rounded off, but remains the same. This ensures that accidental mode
changes do not cause the exact current frequency to be lost.

Auto-Stepping

Auto-stepping is an enhanced form of fixed stepping, in which the step size depends on the
receiver frequency. This facility can also automatically set the mode and squelch threshold
according to frequency.
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Before this feature can be used, it is necessary to set up one or more stepping ranges. To do
this, first select Auto-stepping from the Configure menu. A dialog box will appear,
allowing you to establish the auto-stepping ranges.

To add a range, click on the Add button. Another dialog box will appear, allowing you to
specify the lower and upper frequency limits, the desired step size for that range, the mode,
squelch level, and a text description. The mode, squelch level and description are optional.

You can also edit, delete and move the ranges in the list. If ranges overlap, those at the top of
the list will have higher priority over those lower in the list. You can move ranges higher or
lower in the list by clicking on them and dragging them to the desired location.

If the receiver is not in a specified range, it will default to the fixed step size. If you enter a
different value in the step display, it will change to that step. If the receiver is subsequently
tuned to a defined auto-step range,  the step size for that range will be automatically recalled
and will replace the fixed step.

Whenever the receiver is tuned to a defined auto-step range, the display below the main
frequency readout will show the text description for that range regardless of whether auto-
stepping is active or not. If the current frequency coincides with a frequency previously
stored in memory (see below), the memory comment will take precedence over the text
description.

Memory Stepping

Memory stepping allows the user to step directly between frequencies previously stored in a
memory file. In this mode, the callsign of the current memory entry is shown in the step
display.

If the user types in a frequency which does not correspond to a memory frequency, the
receiver will tune to this frequency without problem. If the user then steps the frequency up
or down, the receiver will find the memory frequency closest to the current frequency in the
same direction, and tune to it.

At least one frequency must be stored in memory for memory stepping to work. If the
memory is empty, memory stepping will not function.

Duplex Stepping

Duplex stepping simplifies listening to full duplex
transmissions, which usually have widely different transmit
and receive frequencies. It can also be used to step between
other widely spaced transmissions, which have the same mode.

To set the frequency separation, select Duplex Separation
from the Configure menu. Any separation can be entered, up
to the maximum tuning range of the receiver.

To step up or down by an amount equal to this separation, press the Home or End keys
respectively. If  the user attempts to step outside the frequency limits of the receiver, the
command will be ignored.

Memory

WiNRADiO has the ability to store up to 1000 frequencies in a memory file, and the
total number of memory files is limited only by hard disk capacity.

Each entry is assigned the following: a number from 0 to 999, the frequency, mode,
group number(s), callsign and comment.

If the receiver is tuned to a frequency stored in the memory, the associated callsign
and comment is displayed in the area below the main frequency readout.
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Storing a Frequency into Memory

To store the current frequency you are tuned to into one of the
1000 memory locations in WiNRADiO, you can either click on
the S button in the Memory panel, or press S on the keyboard.

A dialog box will pop up, and present you with a range of
options you can fill in. At the top of the dialog box is the
frequency you are storing (this cannot be edited). The next line is
the next available memory number that is empty (starting with
zero). You can change this to a memory number that you want
(including ones that already are in use).

The next option is the group assignment. You can assign a
frequency to one or more of 16 different groups. You can set up
frequency groups to suit your particular areas of interest, to
distinguish certain types of stations from others.

Another attribute you can store with a frequency is a callsign. You can store up to 9
characters in the callsign.

A hotkey (function keys F2 to F12) can be associated with a frequency, so that when you
press the key, that frequency is instantly recalled. If a hotkey is being used by another
frequency, it will be shown as ‘(used)’, but you can override the previous assignment with a
new one if you wish.

A comment can also be included with a frequency. The size of the comment is limited by the
width of the text entry line. When the receiver is tuned to this frequency, the text display
below the frequency readout will show the frequency’s callsign and comment entered here.

The mode can also be stored, which will be set automatically when the frequency is recalled.

Finally, one other attribute that can be set is whether the memory number is to be excluded
from a memory scan or not. By default the number is not locked out, but can be locked out
by checking Scan lockout.

Recalling a Frequency from Memory

There are several ways to recall a frequency from memory:

• Use a hotkey;

• Type a number into the memory number display;

• Type a number while holding down the Control key;

• Use the memory recall/view dialog box;

• Use memory stepping.

Hotkey

The quickest way to recall a frequency is to assign a function hotkey to it when you initially
store the frequency. Any function key from F2 to F12 can be used. Note that F1 cannot be
used, as it is reserved for help.

If desired, existing memories can be edited to add a function hotkey (see below).

To recall a frequency using a hotkey, simply press the appropriate function key (F2 to F12),
and it will be recalled instantly. This assumes that a frequency has previously been assigned
to that key, of course.
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Control-Number

To recall any memory, hold down the Control key down while typing the number of the
memory. Alternatively you can click on the memory display, enter the number, and then
press Enter to recall it.

Memory Recall/View

The final alternative is to click on the R button or press
the R key, upon which a memory recall dialog box will
pop up allowing you to view and recall any frequency
from a list. You can limit the list to a subset of
frequencies by specifying a search string, group number
or selected modes. Then click on Find, upon which only
those frequencies which match the search criteria will be
shown.

To tune the receiver to a list entry and keep the memory
viewer open, single-click on it with the left mouse button.
To tune the receiver and close the viewer, double click on it. To tune the receiver to the
frequency it was tuned to before opening the memory viewer, click on Previous.

Editing Memory

To edit an existing memory entry, first click on the R button or press the R key.
Select the memory to edit from the list, then click on Edit.

You are able to modify every setting, including the frequency, except for the
actual memory number.

To edit the next memory entry, click on the Next button.

Saving and Loading Memory Files

WiNRADiO stores 1000 frequencies in each memory file. You can choose which file is
currently active, and you can also save the file under a different name.

When you start your WiNRADiO receiver for the first time, it creates a memory file called
winradio.wrm. Every time you close your WiNRADiO session, the memory is automatically
saved to the active file. To perform an immediate save, select File - Memory file - Save.

To open another memory file, select File - Memory file - Open. Before the new file is
opened, and if the current memory file has been modified during the current session, you
will be asked if you want to save the changes or not. Next, a dialog box will appear which
allows you to open a different memory file (or reopen the same one discarding any changes
since it was last opened). The selected file will now become the active memory file.

To rename the current active file and save it under a different name, select Save as from the
same submenu. A similar dialog box will appear, where you can specify the new filename
and/or path.

New Memory File

To clear all frequencies and start a new file, select File – Memory file – New. Before the
new file is opened, and if the current memory file has been modified during the current
session, you will be asked if you want to save the changes or not. A dialog box will then
appear, prompting you to enter the name of the new file.
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Scanning

WiNRADiO provides a variety of scanning functions and options, to
allow you to optimise the way you search for stations.

The scanner steps through frequencies until it finds a transmission that
has a signal strength greater than the squelch value.

The following sections describe the available scanning methods and
associated options.

Immediate Scanning

Immediate scanning is the quickest and simplest way to search for stations. To
activate this, first set the desired stepping mode and step size if necessary, then click
on the immediate scan up or scan down button. The receiver will then start scanning
up or down from the current frequency, according to the selected step size.

If the receivers encounters a signal which has the same or higher strength than the
current squelch threshold, it will either pause or stop, depending on the selected
scanning options.

To access immediate scanning from the keyboard, use the Insert or Delete keys to scan up
or down respectively. To cancel immediate scanning, press the Escape key.

Frequency Range Scanning

Frequency Range scanning provides an extension to
immediate scanning in  'Fixed Step' mode. It allows
you to specify a number of ranges of frequencies to
scan. You can enter the start and end frequencies,
the step size, mode and squelch setting for the range
to scan. You can add this range to a list from which
you can pick the ranges you want to scan. Each
range can also have an associated description.

Click on the Start Scan button to start scanning
from the first selected range, or click on Close button to exit the dialog box (it will
remember your settings and ranges). If you have already performed a range scan and have
not changed the range selection, you can resume the range scan from where it was stopped
by clicking on Resume previous scan.

When scanning in this mode and the scanner reaches the end of the current range, it either
goes to the next range selected, or loops back to the start of the first range selected.

The range list allows you to add, edit and remove ranges, and you can click on one or more
ranges to select them for scanning.

Any ranges with descriptions can be selected in the 'Spectrum Scope' for a sweep to be
performed on the associated range.

Memory Scan

Memory scanning provides an extension to immediate
scanning in ‘Memory Step’ mode. In addition to the
basic stepping through the memory frequencies, it
allows you to specify a subset of memory frequencies to
scan by selecting a range of memory numbers, modes
and one or more groups.

To start the memory scanner, click on the Memory
button or press the M key. The memory scan dialog box
will appear.
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Select the range of memory numbers to scan, mode and group restrictions. Click on the Scan
button to start scanning, or click on the Close button to exit the dialog box (your settings will
be remembered).

When the scanner reaches the end of the memory range, it loops back to the start of the range
and starts again.

A feature provided with memory scanning allows you to assign ‘priority’ memory number.
When this is used, the priority memory number is scanned after a certain number of
memories is scanned. How many frequencies are scanned before the priority frequency is
specified by the Scanning interval.

Scanner Options

There are several options that can be set for the scanner to suit your needs. You can specify
how the scanner operates when it pauses at a signal and how fast it scans.

When the scanner finds a signal, it has two basic options: pause or stop. If ‘pause’ is
specified, you can force the scanner to continue, stop, exclude or wait.

If you leave it waiting, there are four different options to allow it to continue automatically:

• When the signal disappears (drops below the squelch level)

• After a fixed period of time (regardless of the signal level)

• When the signal disappears during a fixed period of time or after the fixed period of
time (whichever comes first)

• After a signal disappears for at least a fixed period of time.

The fixed period of time is specified by the ‘Delay time’.

The scan rate specifies the maximum number of frequencies per second the scanner will
check, but could be slower than specified if you have other programs running.

When the scanner stops or pauses at a signal, you can set it up to perform certain tasks:

• Write the frequency to memory

• Store the settings into the log

• Start recording the audio to a sound file

• Alert the operator

To write the frequency to memory, select Write to
memory and specify the range of memory numbers
that the scanner can write to. You can also assign a
group number that the frequency will be associated
with. Check the Confirm box to confirm each
frequency before it is written.

To store the current settings (frequency, mode, date,
time and signal strength) to the log, select Store to
log.

The audio signal can be recorded when a
transmission is found by selecting Record audio, specifying a file name to record to and
specifying the sampling rate and bits per sample.

The file name can also include a #d, #t, and/or #f to specify the date, time and frequency
respectively. If you need a # in the file name, enter ## (double-hash). The date and time will
be represented as a six digit number. The date order depends on your country settings in
Windows (will be typically DDMMYY or MMDDYY), and the time is HHMMSS (24
hour). The frequency will be represented by a number in kHz with no leading zeros, spaces
or decimal places.
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The WiNRADiO scanner can also alert the operator by means other than the scanner dialog
box. The operator can be alerted by an audible beep and/or by sending data on a parallel
port, typically for remote notification.

WiNRADiO can have two separate squelch settings: one for audio and one for scanning.
This option is specified under ‘General Options’ in the ‘Configure’ menu. If this feature is
enabled, another control is visible at the bottom of the dialog box. It allows you to specify
the scanner squelch while the audio squelch remains controlled from the main panel.

Exclusions

To avoid the scanner stopping at unwanted
frequencies, your WiNRADiO software can
maintain a frequency exclusion list. The
exclusion list contains a list of frequency
ranges which are skipped by the scanner.

During a scan, you have the option of adding
frequencies to the exclusion list by clicking
on the Exclude button (this option is enabled
by checking Enable excluding while
scanning at the bottom of the ‘Scanning
Exclusions’ dialog box). The range that is
excluded depends on the mode. In CW, LSB
and USB modes, the default range excluded is ±999 Hz, AM is
±1.999 kHz, FMN is ±6.249 kHz and FMW is ±49.999 kHz of the current receiver
frequency. If you want to change any of these default values after they have been added,
select the exclusion from the list and click on the Edit button.

You can also manually add exclusions by clicking on the Add button, edit or delete existing
ranges. There is no priority system, if the frequency is within any range in the list, it will be
ignored by the scanner.

Miscellaneous

Mute

The Mute button controls the audio output of your WiNRADiO receiver. If it is on, the
output is muted (switched off). To activate (or deactivate) the mute control, click on it or
press Ctrl+U.

Passband Tuning (IF Shift)

In CW, LSB and USB modes, a control is enabled at the top-left corner of  the
panel to allow you to adjust the passband tuning of the receiver. This controls
the quality of the audio reception of an SSB transmission. The IF can be shifted
up to 3000 Hz above or below the normal location.

To use the control, click on the display and enter the frequency in Hz. To set
the frequency from the keyboard, press I or Ctrl+B and enter the frequency. To quickly reset
the display to 0, press the Reset button or the ‘star’ key on the numeric keypad.

Indicators

The three LED-like indicators indicate various states of your WiNRADiO
receiever.

The squelch indicator, ‘Sqlch’, is green when the squelch is inactive (the
audio output is open), and red when it is active or about to activate
(depending on the ‘Squelch delay’ time specified under ‘Configure - General Options’).
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The ‘PLL’ indicator shows the lock status of the receiver’s Phase Lock Loop. When
operating normally, the indicator is green. If something goes wrong, it will turn red
indicating that the receiver cannot tune into a specific frequency.

The ‘Power’ indicator indicates that the receiver is powered up.

Power Switch

The power switch controls the radio receiver’s power. When it is off, the actual receiver
circuitry is powered down.

Date and Time Displays

The date and time displays show the current local time and UTC
standard time. The actual format of the displays is controlled by
‘Regional Settings’ in the Control Panel (or ‘International’ in
Windows 3.1 and NT 3.5) and to a lesser degree in the ‘Date and
Time’ dialog activated from the ‘Configure’ menu.

The time difference between the local time and UTC is set
under ‘Date/Time’ in the Control Panel in Windows 95 and
NT, while in Windows 3.1 you have to manually specify it
in the ‘Date and Time’ configuration dialog box. If the
default provided is incorrect and you wish to override the
default, select Override default time zone and enter the
difference.

If you are in a country with 12-hour time, you can specify
whether to show the local time in 12 or 24-hour format and
whether to show UTC in 24-hour format.

If you are in a country with 24-hour time, you have no
option to show the time in the 12-hour format.

Window Properties

There are several features that allow the customisation of
your WiNRADiO interface. These include:

• size of the window

• position of the panel in the window if the window is
smaller than the panel

• background colour

• whether it is always on top of all other windows

• whether the title and menu bars are hidden for a smaller window

The first two are basic Windows features. The window that contains the receiver panel can
be positioned anywhere in the Windows desktop and can be sized to be as big or as small as
you want. When the window is smaller than the actual panel, scroll bars will appear to allow
you to access hidden parts of the panel as shown here.
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Background Colour

To adjust the background colour, select Background Colour from the View menu. A dialog
box will appear that allows you to specify the colour you want for your background.

You can select one of several predefined colours, visually select a colour using the colour
box (hue v saturation) and the ‘luminance’, or enter the colour specifying actual RGB or
HSL values.

Click on Apply to see the colour before closing the dialog box.

Always On Top

This facility allows the WiNRADiO window to remain always visible, even when using
other programs (such as a word processor). To enable the WiNRADiO window to do this,
select Always on top from the View menu. A check mark will appear next to this menu
command. To undo this option, select the menu command again, and the check mark will be
removed and WiNRADiO will act like other normal windows.

Hide Title Bar

The ability to hide the title bar and menu allows you to reduce the overall
size of the window. To activate this feature, select Hide title bar in the
View menu.

This feature is especially useful in conjunction with the ‘Always On Top’
feature to allow a small window to sit on top of all windows. For example,
you could just show the current frequency as shown here.

To access the menu commands, click on the little button that is visible in
the top-left corner of the window. To move the window around the screen, click-and-drag on
any inactive part of the WiNRADiO panel or background. To show the title bar and menu,
select the Hide title bar command in the View menu.

General Options

Other configurable options for WiNRADiO have been grouped
into a common dialog box called ‘General Options’ which is
accessed from the ‘Configure’ menu.

The Frequency readout offset specifies a value that is added to the
displayed frequency. It is useful if you are receiving a transmission
through a down-converter (to receive frequencies higher than
upper limit of the receiver).

The other options are self-explanatory, if you need more explanation about a particular
feature, refer to the on-line help.
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Spectrum Scope

The ‘Spectrum Scope’ is a utility to display and store the signal level across a frequency
range. After a frequency sweep has been performed, you can tune to any frequency on the
display. To tune to a frequency or peak on the display, click on it. You can hold down the
mouse button and drag the cursor across the display quickly tuning to any frequency on the
display (this facility will be described in greater detail under chapter heading ‘VisiTune’).
You can even configure it to tune another receiver card into the selected frequency. Double-
clicking finds and tunes to the closest peak.

Mathematical functions can be applied to the sweeps to help find transmissions you are after.
Every sweep is recorded and can be saved to a file to be viewed at a later time and different
analytical functions applied to the data. Markers can also be added to the sweep, and the
sweeps can be printed.

Spectrum Sweeping

To perform a spectrum sweep, you have two methods of specifying the frequency range.
You can either specify it by the start and stop frequencies, or by the centre frequency and the
width of the sweep. To specify a sweep method, see the following section on ‘Options’.

Next, you specify the step size depending on the resolution and speed you want. The
resolution bandwidth (RBW) also has an effect on the step size. For a slower, higher detail
sweep, select a small step size, and in contrast, for a quick, coarse sweep, select a large step
size. For example, if you are using the 17 kHz RBW, step sizes below 10 kHz are not useful;
all signals would be captured at 10 kHz. A 5 kHz step is suitable for a fairly detailed sweep
using an RBW of 6 kHz. If you select a step size larger than the RBW, it is possible that
signals will be missed that are located between two stepped frequencies.

Once you have specified the parameters, click on the Sweep button to perform a sweep.

Every time you change any parameter (except the resolution bandwidth), any previous
sweeps will be cleared when you start a new sweep. The bandwidth can be changed at any
time, even in the middle of a sweep. Up to 200 sweeps will be stored. If more than 200
sweeps are performed with the same parameters, then every successive sweep will delete the
earliest sweep recorded.

To stop a sweep prematurely, click on the Stop button (which is the ‘Sweep’ button with a
different caption). If you stop, clicking on the sweep button again will start a new sweep
from the start (but the previous sweep will be preserved until a parameter is changed).

Alternatively, you can click on the Pause button to pause the sweeping and click on it again
to let the scope resume from the frequency it was paused at.



WR-3700 Series User’s Guide

21

VisiTune™

A unique feature of the WiNRADiO Spectrum Scope makes it possible to smoothly tune the
receiver by dragging the mouse against a spectrum background. This feature is called
‘VisiTune’.

When you click on a spectrum sweep with the left mouse button, the receiver will tune to the
frequency where the mouse is located (the frequency is displayed in the top-left corner of the
scope window). If you hold the mouse button down and drag it left or right, the receiver will
immediately respond to your movements, allowing you to directly inspect transmissions
visible on the spectrum sweep.

If you double-click at a point on the display, WiNRADiO will search for the highest peak
nearest the cursor depending on the slope of the sweep at the cursor. It will check the level at
either side of the frequency where you double-clicked. It will then follow the slope that rises
towards a peak until it reaches a peak. It you click at a valley, it will search both sides for the
highest peak. Clicking on a flat part will not start a search for a peak.

To make VisiTune more useful, you can configure the spectrum scope to  use another
receiver for sweeping. If you have another WiNRADiO card installed, this allows you to let
the spectrum scope to continually sweep the band you are interested in and at the same time
tune and listen to any frequency in the sweep. See the ‘Options’ section for more
information on configuring this feature.

Other tuning methods can be accessed from the context menu, invoked by clicking with the
right mouse button on the display. You can choose Tune to current frequency and Tune to
current peak to tune the same as above. Alternatively, you can select Tune to maximum
peak and Tune to average peak to tune to a peak on those calculated sweeps respectively.

You can also explicitly select a receiver to tune the frequency to, other than the default. If
you have two or more WiNRADiOs you can tune one of these other receivers to the
frequency or frequency peak. Click on the appropriate receiver under ‘Tune other receiver to
freq’.

Finally, if you have only one receiver, you might wish to enable the Manual refresh feature
under ‘Options’. When enabled, the background spectrum graph will be updated while you
are navigating around it with the left-hand mouse button held down (note that, with the fast
hand movements over a large frequency range, the receiver’s settling time might not allow
accurate updating of the displayed spectrum).

Markers

You can add frequency markers to a spectrum sweep to assist you in finding and monitoring
a frequency (or several frequencies) during a sweep. Markers are also saved when you save
the sweep(s) to a file.

To add a new marker, pop up the context menu (click on the display with the right mouse
button) and select Add marker. A marker’s properties can also be modified. Right mouse-
click near the marker and select Marker properties. You can change the marker’s
frequency and colour. To delete a marker, select Clear marker from the context menu. To
tune to a marker, select Tune to marker from the menu.

Saving and Loading Files

Every sweep is recorded until a new sweep is performed with different parameters. To save
sweep data, click on the File button and select Save from the pop up menu. Enter a file name
in the dialog that appears and click on OK to save the file. All sweeps and markers will be
saved in the file.

To load a previously saved file, click on Open from the File menu. Select the file and click
on OK. Any previous sweep data will be immediately cleared.
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Printing

Every sweep can be printed for archiving and
presentations. Click on Print in the file menu. A
dialog box will pop up allowing you to specify several
settings for printing. You can specify which sweeps to
print (including calculated ones), the printer to print to
(and its configuration), the margins on the paper (so
you can print on a certain part of the paper), paper
orientation, how many pages for the spectrum (so you
can print it out like a banner) and whether to print
each selected sweep separately or combined into one
print-out.

Each individual sweep is shown by when it was actually performed (date, starting time and
finishing time).

Options

Several aspects of the spectrum scope can be customised.

The first is the sweep range specification, you can choose either start and stop frequencies,
or the centre frequency and the width of the sweep. Select the appropriate method in the
dialog box.

You can set up WiNRADiO to mute the audio or not when it starts a sweep. It will mute the
audio if Mute while sweeping is checked.

If Continuous sweeping is checked, when the sweeper gets to the end of a sweep, it will
start a new sweep immediately until this option is unchecked or you click on the Stop
button.

The ‘Sweep on’ list allows you to specify which receiver card should be used for sweeping.
The list shows all currently available receiver cards.

‘VisiTune manual refresh’, when enabled, forces updating of the spectrum display under the
frequency cursor (thus allowing a ‘manual sweep’ with the mouse if the left mouse button is
held down).

The ‘Previous sweeps’ section allows you to show a certain number of sweeps that were
done prior to the most recent. You can specify how many to show and the colour for each of
them.

You can also control the colour of the current sweep, calculated sweeps and all the actual
sweeps. By default, only the current, maximum and exponential average sweeps are visible.
To see a sweep, select it (or several) from the list and choose a colour to show the sweep(s)
in. To hide a sweep, select invisible at the top of the colour list.

Finally, you can specify how many sweeps to use for the ‘Rectangular average’ calculated
sweep and the weighting factor for the ‘Exponential average’ sweep.
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Task Scheduler

WiNRADiO includes an advanced task scheduler that can be configured to schedule almost
any task that WiNRADiO can perform. Each task can be triggered by a selected combination
of date and time, signal level rise or fall and DSP event. Each task can activate any number
of times and time-triggered tasks can occur at discrete intervals.

You can also save and load schedules to different files.

Using the Scheduler

To utilise the scheduling facilities of WiNRADiO,
select Schedule from the Scheduler menu. A
window will pop up showing a list of scheduled
tasks and buttons to manipulate the schedule.
Initially the list will be empty.

To use the scheduler, you have to add tasks to the schedule. Click on the Add button to add a
new task. See the following section ‘Adding a Task to the Schedule’.

Once you have entered the desired tasks, WiNRADiO will continually monitor these active
events and will perform the associated task when the conditions are met.

When a time activated task is about to trigger, a window will appear informing you that a
task is about to occur allowing you to skip or postpone the task. If you wish to have the task
proceed normally, you can either click on OK or ignore the window (it will disappear when
the task occurs). You have the option of specifying whether the notification appears, the
period of time before it appears and whether to beep or not when it appears.

Signal level transitions and DSP-triggered tasks will occur without any warning.

One or more tasks can be disabled (and re-enabled at a later time) by selecting the tasks to
disable and checking the Disabled check box.

You can also schedule more than one task to activate at the same time, they will be executed
in the sequence shown in the list.

Adding a Task to the Schedule

Event Triggers

A scheduled task can be triggered by different
methods. The trigger can be a selected
combination of time, signal level change and DSP
event. Depending on which triggers are used, the
task will activate when either the signal transition
or DSP event conditions are met, and at or after
the specified date and time.

Date and Time

If you would like a task to be performed at (or after, if using the signal transition or DSP
events) a certain time and day, check the Date check box and enter the date and time. You
can also specify how often to repeat the task and the period of time to wait between each
task in the ‘Repetitions’ section.

A time triggered task can also be performed everyday at a certain time or on certain selected
days of the week.
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Signal Strength Transition

A task can be set to be performed when the signal level rises and stays above (or falls and
stays below) a certain threshold for a certain period of time. Check the Signal transition
check box, and set the parameters accordingly, if you want to take advantage of this feature.

Used on its own (or with the DSP event), this task can trigger at any time while WiNRADiO
is operating. If you would like it to trigger after a certain time, specify a date and time trigger
event.

DSP Event

This specialised trigger method relies on DSP applets. DSP applets are programs that run on
the DSP resident on the Spectrum Monitor card. Certain external DSP applets can be set to
generate an event to make WiNRADiO perform a certain task. For example, when the DSP
is decoding and monitoring digital data, it could be made to search for a certain sequence
and trigger WiNRADiO to record the transmission.

Each DSP applet can be unique in its features. Click on the Configure button to set up the
applet’s event trigger.

Similarly to the signal strength trigger, you can configure the task to trigger after a certain
date and time by activating the date and time trigger and specifying the date and time.

The DSP and signal strength transition triggers are independent of each other and, if both are
active, the task will activate if either of the two meet its set conditions.

Tasks That Can Be Performed

The three events can be configured to trigger any one of eleven tasks. Select the appropriate
task that you would like WiNRADiO to perform and configure the options associated with
the task.

Change Settings

WiNRADiO can be set to a particular frequency, mode, volume, squelch, attenuator, mute
and power state. By default, none of these settings are changed (frequency, volume and
squelch are blank, mode is set to ‘(N/A)’ and the Atten, Mute and Power check boxes are
greyed). To change any particular setting, specify a value in the appropriate control.

Recall Memory

To recall a memory at a specific event, select Recall Memory
from the task list and specify a memory number to recall when the
event occurs.

Store Details to Log

The current settings and signal level can be recorded to the log file
using the Store details to log task. Specify a comment for the log
entry to be added.

Start DSP Applet

A DSP applet can be activated to perform  certain functions,
typically decoding. Select the applet from the list of installed
applets.

Start/Stop Recording

To record the audio to a file automatically, select Start recording.
Select the audio properties, file name and an optional maximum
file size. When the recording starts, it will only be stopped by
manually clicking on the stop button, reaching the maximum file
size or by a ‘Stop recording’ event (and also if the destination runs
low on space, about 5 MB).
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The file name can also include a #d, #t, #f and/or #n to specify the date, time, frequency and
a unique number respectively. If you need a # in the file name, enter ## (double-hash). The
date and time will be represented as a 6 digit number and the frequency is in kHz. The date
order depends on your country settings in Windows (will be typically DDMMYY or
MMDDYY), and the time is HHMMSS (24 hour).  The number is represented as a four digit
number with leading zeros.  See the section on ‘Repetition Options’ for details on setting
how many times a task is performed.

Start/Stop Scanning

The scheduler can automatically start a range or memory scan. Select
the scanning method and set up the parameters for the scan. You can
also configure the scanner options. These configurations are local and
do not affect the normal scanning options activated on the panel.

Perform Spectrum Sweep

To perform a spectrum sweep of a specific band, select Perform
spectrum sweep from the task list. Specify the start and stop
frequencies (you cannot specify a centre frequency and sweep width
like in the spectrum scope), step size, resolution bandwidth and a file
name to store the spectrum file (this also allows the use of the #d, #t and
#n specifiers).

When the event triggers, the spectrum scope will activate (pausing any
scanning or sweeping that may be occurring at the time), sweep the
range to the file and close (and resuming anything that paused).

Record Signal Strength

A signal strength recording of a particular frequency can be
automatically performed. You can specify the interval and duration
of the recording. If you specify an existing file, the data will be
appended to the file. If the settings are the same as an existing trace,
the new signal strength data will be appended to the same trace,
otherwise a new trace is created.

If a signal strength recording is already in operation, a new trace will be automatically added
and the new interval will be set (unless it is left blank). The file name will be left unchanged.

Alert Operator

The operator can be alerted simply by making the computer pop up a
message, beep and/or by sending a command to an external device
through a parallel port. If you select Show message you can enter a
custom message to show. If you select Send data, you can specify
the port and the data to send to the port (in decimal or hexadecimal).

Repetition Options

Each event can be repeated multiple times, from once to almost ten thousand times and also
infinitely. If the task is triggered by the date and time, the period of time between each
repetition can be specified to the nearest 6 seconds (1/10 of a minute) up to 99 hours and 59.9
minutes. Alternatively, you can set it to repeat daily or on certain days during a week.

Saving and Loading Schedules

All schedules are saved to a file. You can save a schedule in a different file by selecting
Save as from the Scheduler menu (schedules are always saved automatically). This new file
becomes the active schedule.

To load a different schedule, select Open from the Schedule menu, and to create a new
schedule, select New. In both cases the new schedule is the active schedule.
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Sound Recorder

The inbuilt DSP allows WiNRADiO to record and playback audio files without the need for
a separate sound card.

The file generated is a standard Windows .WAV
file which can be played by any third party
software application. WiNRADiO can even play
most wave files generated by other applications
(mono only).

There are several audio formats you can record in, depending on your choice of quality
versus file size. There are three sampling rates and two different bits per sample to choose
from: 8, 11 and 16 kHz sampling, 8 and 16 bits per sample. 8 kHz, 8 bit sampling results in
the least number of bytes per second, while the 16 kHz, 16 bit sampling results in the highest
quality audio reproduction. The audio format is specified from the 'Audio format' sub-menu
under the 'Accessories' menu.

Sound files can be recorded manually or automatically by the scheduler.

Recording

To record a file, first select Sound recorder from the Accessories menu. Click on the record
button (the solid red circle) to start recording. To stop recording, click on the stop button
(solid blue square). You will be prompted for a file name to save the recording to. The
recorded file can now be played, or you can record another file (or close the sound recorder).

You can pause recording temporarily by clicking on the pause button, and resume by
clicking on the pause button again.

Playback

You can either play a file you just recorded or load another file and play it back. To play an
existing file, click on the Open button and select the file. Click on the play button.

You can move anywhere in the file by either adjusting the position on the scroll bar or
clicking on one of the three navigation buttons. The left-most moves the position to the start
of the file while the fast forward and rewind buttons move forward and backwards through
the file respectively.

While a file is being played, you will not be able to hear the radio until it is stopped again.
While playback is paused, the audio output is silent.

Signal Strength Recorder

The signal strength recorder is a useful feature for channel monitoring. It records the signal
strength of several frequencies over a period of time showing the results on a display similar
to the spectrum scope.

Up to 100 separate traces can be recorded and you can specify how often a signal sample is
to be taken for each enabled trace. Traces can be added at any time and existing traces can be
disabled (no samples are taken) or re-enabled. The sampling rate can be changed within a
session by stopping the sampling, editing the interval and restarting.

The signal strength recorder is a file-based recorder (like the Sound Recorder) and is
continually saving the information to a file.

Using the Signal Strength Recorder

To use the signal strength recorder, select Signal Strength Recorder from the Accessories
menu.
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Initially, you have to add a trace (or more) to be recorded by clicking on the Add button.
Enter the appropriate data. You can also specify a colour to show the trace on the display.

A list of traces is shown in the drop-down list to the left of the ‘Add’ button. If you wish to
edit, disable/enable or delete any traces, select a trace and click on Edit, Disable/Enable or
Delete buttons respectively. When a trace is deleted, it cannot be recovered (except by re-
opening the same file if it was previously saved). If you wish to stop a trace, but not delete it,
click on the Disable button. You can re-enable it by clicking on the Enable button. The only
property of a trace that can be edited is the colour (select ‘invisible’ to hide the trace).

Enter an interval in the ‘Interval’ edit box (up to 99 hours, 59 minutes and 59 seconds). An
interval of 00:00:00 will sample the signal strength as quickly as possible (this depends upon
the number of enabled traces and the mode for each trace).

Click on Start to start recording.

When you have finished recording the signal strength, click on Stop and you can now save it
to a file.

If you close the recorder and the recording hasn’t been saved since it was last modified, you
will be asked if you want to save the changes before the recorder closes. If it is a new
(unnamed) file, you will be asked to enter a file name.

Saving and Loading Files

To save a file, select Save or Save as from the File menu. Enter a file name in the dialog box
that appears, and click on OK. If you select Save for a previously saved file, you will not be
prompted for a file name.

To load a previously recorded file, select Open from the File menu. Choose a file from the
dialog box and click on OK. You may continue recording to the end of the file, including
adding, editing and removing channels (the new data is appended to the existing file).

To create a new recording, select New from the File menu. If the current recording hasn’t
been saved since it was last modified, you will be asked if you want to save the changes.

Options

To set up the various features of the signal strength
recorder, click on the Setup button. A dialog box will
appear to allow you to configure the recorder.

The vertical scale of the display can be configured to
show only part of the range instead of the full 0-120 range
of the signal strength.

The recorder can also be set to mute the audio when it
does a sample run.

 Logger

The WiNRADiO Logging facility can store the date, time, frequency, mode, level and a
comment. When a log entry is added from WiNRADiO, the current date, time, frequency,
mode and signal level is appended to the log.

Adding a Log Entry

To add the current settings to the log, either
select Add to log from the Logger menu, or
press Ctrl+L.

If you have Prompt for log comment checked
in the General Options dialog box, a small
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dialog box will pop up asking you for a comment. Otherwise, the settings are stored to the
log without a comment.

The Log Editor

WiNRADiO Spectrum Monitor uses a separate program to view and edit the log files it
generates. To view and/or edit the log, select Edit log from the Logger menu. The
'WiNRADiO Log Editor' will start up loading the currently active log file.

The editor allows you to open multiple files at the same time, cut, copy and paste between
them. You can modify and print the contents, search and sort and tune WiNRADiO to any
entry. You can even copy a range of entries to the clipboard and paste them into another
program such as Microsoft's Excel or Corel's Quattro Pro.

Editing Log Entries

To edit a log entry, select the cell to modify and enter the new data.

To add a new entry, select Insert row from the Edit menu, click on the insert row button or
press the Insert key.

To delete an entire entry or delete a range of entries, select the row by click-and-
dragging on the column to the right of the date column. Select Delete row(s) from

the Edit menu, click on the delete row button or press the Ctrl+Delete keys.

The log editor supports multiple undo/redo. If you want to undo any changes you have
made, click on the undo button, select Undo from the Edit menu or press Ctrl+Z. You can
continue undoing previous changes until the undo button goes grey (indicating there is
nothing left to undo). To redo any undone changes, click on the redo button, select Redo
from the Edit menu or press Ctrl+Y. You can redo all recently undone changes. The
moment you modify anything you cannot redo the changes that were undone.

The only other way to modify a file is using the cut, copy and paste functions. If you want to
move rows around, select the row(s) you want to move, and click on the cut button (or select
Cut from the Edit menu or press Ctrl+X). Select the cell on the row above which you want
to insert the cut row. Now click on the paste button (or select Paste or press Ctrl+V). The
cut row will be inserted above the row where the active cell is. You can also copy rows
using copy instead of cut, and you can also cut, copy and paste between different files.

Opening and Saving Log Files
To open an existing log file, click on the open button, select Open from the File menu or by
pressing Ctrl+O. A dialog box will appear where you select the file that you want to open.
A new window will appear in the editor with the contents of the log file.

You can create a new log file by clicking on the new button, selecting New from the File
menu or by pressing Ctrl+N. A new window will appear in the editor with one entry with
the current date and time (and everything else is empty).
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You can also save the active file that has been modified by clicking on the save button,
selecting Save from the menu or by pressing Ctrl+S. If it is a new file, you will be prompted
for a name to save the file under. If you exit the log editor without saving modified files, you
will be asked whether you want to save each file or not.

If you want to save the current file under a different name and/or location, select Save as
from the menu and enter a new file name.

Printing

To print a log, click on the print button, select Print from the File menu or press Ctrl+P. A
dialog box will pop up showing the current printer selected, the entries to print and number
of copies to print.

If you want to change the printer you are printing to or change the settings of the printer,
click on the Setup button.

The footer (if you choose to print it) contains the name of the file you are printing and the
page number.

Searching

To search for a log entry, click on the find button, select Find from the Tools menu or press
Ctrl+F.

A dialog box will pop up where you can specify the parameters to search for. As shown, you
can search for entries that were stored during a particular time, a frequency range, modes,
signal strength range and/or comment substring.

Click on OK to search for the first matching log entry.

To find the next matching entry, click on the find next button, select Find next from the
Tools menu or press the F3 key.

Sorting

The entire log file, or a selected range, can be sorted
according to the date and time, frequency or signal
level in ascending or descending order. Initially, it is
sorted according to the date and time, earliest first (this
is how they are added from WiNRADiO).

To sort the entries, click on the sort button or select
Sort from the Tools menu. A dialog box will appear
where you can specify the sort order. Click on OK to
sort the entries.

Tuning WiNRADiO to a Log Entry
The log editor can tune WiNRADiO into any frequency stored in a log (the frequency range
and modes may be limited by the WiNRADiO receiver). Select the row containing the
frequency and mode you want to tune to and click on the tune to frequency button, select
Tune to frequency from the Tools menu or press Ctrl+T.

If WiNRADiO is not running, the log editor will attempt to start WiNRADiO. If it cannot
start WiNRADiO, a message will appear saying that it could not open communications with
WiNRADiO. If this happens, you have to start WiNRADiO manually for this feature to
work.

Selecting a Log File

WiNRADiO can add log entries to any log file. To choose the log file to add entries to,
select Log file from the Logger menu. Either choose an existing log file or enter a name for
the new log file to create in the dialog box that appears.
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External Antenna Control

Many installations use at least one antenna, each antenna being suited for a particular
frequency band. For adequate full spectrum reception, at least two antennas are required: an
HF and a VHF/UHF antenna, typically a wire and a discone respectively.

Using a suitable external logic control box connected to a parallel port on the PC,
WiNRADiO can automatically switch between antennas according to the frequency
WiNRADiO is tuned to.

If this feature is used, the entire frequency range of WiNRADiO (150 kHz to 1.5 GHz)
should be covered. Otherwise, if you tune to an unspecified range, the reception can be very
poor due to the wrong antenna being selected.

To set the antenna control up, select
External antenna control from the
Configure menu. A dialog box will
appear showing any frequency ranges
that control the antenna, the parallel port
and the data sent to the port. You should
not connect any printers to the parallel
port you are using for antenna control
and similarly, you should not specify a
parallel port that a printer is connected to.

If you require an additional parallel port,
an additional I/O card needs to be installed. You need to make sure it can be set up for LPT2
or 3 and the serial ports (if the card contains any) can be configured or disabled, otherwise
they may conflict with your existing ports.

To add a frequency range, click on the
Add button. Another dialog box will
appear where you can enter the frequency
range, select the parallel port and the data
sent to the port. You have three methods
of specifying the data to send: decimal
value, hexadecimal value and selecting
the pins that go high (5 volts). If you
change one setting, all the other settings
change appropriately. A diagram of the
parallel port (showing the socket on the
PC) is shown to assist with wiring up a
custom control unit.

You can also edit and delete existing ranges.

When the receiver enters a range, the associated data is sent to the parallel port and the
strobe line (pin 1, normally low) is pulsed to allow external logic to latch any data it requires
(the data remains until another frequency range is entered).
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DSP

The WiNRADiO Spectrum Monitor internal receiver (WR-3700i-DSP) has a DSP fitted to
allow digital processing of the audio from the receiver. This gives the receiver the ability to
filter the audio, decode digital data and perform other processing on the audio signal.

In-built DSP applets allow recording and playback from the Sound Recorder feature. For
customer specific applications, developers' information is available to allow new DSP
software to be added to the basic WiNRADiO Spectrum Monitor software.

Using a DSP Applet

All installed DSP applets appear in the 'DSP' menu in WiNRADiO. To start up an applet,
select the appropriate applet from the menu. A window will appear allowing you to setup
various parameters associated with the applet. All WiNRADiO functions can still be used
while the applet is still running.

Adding a DSP Applet

To add a new applet, copy the file into the directory where WiNRADiO is installed. Applet
files have a .DSP extension. If WiNRADiO is already running, close it down first.

When WiNRADiO starts up, it will load all the DSP applets found in its directory and add
the applet's functions to the DSP menu.

Signal Conditioner Applet

The WiNRADiO Spectrum Monitor software comes supplied with a DSP applet that
provides high performance post-demodulation audio filtering, which is particularly useful
when receiving CW and SSB signals, and in some cases (for example HF broadcast) AM.

To run this DSP applet, select corresponding item in the DSP menu (ie. DSP - Start applet -
Signal Conditioner). The following window appears on the screen:

This is the description of the controls:

1. Bandpass Filter enables the audio ‘brick wall’ band pass filter. See ‘6’ and ‘7’ to tune
the filter response in real time.

2. Noise Reduction enables adaptive random noise filtering. This option works better for
higher signal-to-noise ratios.

3. Auto Notch enables adaptive automatic heterodyne cancellation. The Auto Notch
eliminates multiple tones form the audio spectrum. This is very useful to cancel ‘carrier
signals’, while receiving SSB-modulated signals.

4. Marker Tone activates generation of audible tone with its frequency equal to the centre
frequency of the pass band of the filter. This is useful guide for tunning-in on CW
signals. A complementary visual guide is the real time FFT display (8).
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5. Gain sets the pre-processing numerical gain of the signal inside the DSP. This parameter
helps to resolve the ‘signal-to-noise vs. audio distortion’ trade-off. If the filtered signal
sounds too distorted, choose a lower gain. The ‘AGC’ option activates automatic gain
control algorithm. This function does not supplement the main AGC for the receiver, as
it is applied only 'inside' the DSP as an automatic numerical amplification adjustment.

6. Low/High/Centre/Width parameters control the corresponding pass band frequencies of
the filter. The two pairs (Low/High and Centre/Width) are synchronized, so that change
in one parameter is subsequently transformed into change of the others. The entered
numbers are rounded to 10Hz steps.

7. Interactive filter tunning control. You can independently drag the lower and upper
transition bands with the mouse. It is also possible to move the whole pass band ('tune'),
simply by dragging the upper horizontal part of the displayed response.

8. Real time FFT display. Shows the spectrum of the audio signal. The vertical range of
the display is 80dB. Frequency axis marks are displayed above the FFT display.

9. FFT Source - selects whether the FFT is computed before or after filtering of the signal.

10. Bar toggles between displaying spectral envelope and spectral lines, while Grid enables
the green rectangular grid on the FFT display.

11. Exit stops the Signal Conditioner applet and unloads the DSP, so that other task
(different applet or the Sound Recorder) can be performed. It is possible to stop the
applet by selecting ‘DSP - Stop applet’ in the WR-3700i-DSP menu.

12. About displays the version info.

13. Settings is used to store and quickly retrieve different combinations of control
parameters. To Store current setting, type any desired name into the 'listbox' line and the
click the 'Save' button. To recall pre-stored settings, simply select the proper name in the
'listbox'. To remove selected item form the list box, click the 'Delete' button.

Note: The Band pass filter uses finite impulse response (FIR ) design, so the phase delay
response is inherently linear. This filter is ideal for 'cleaning up' any data mode before
outputting the signal to a third party decoder. To adjust the filter to any FSK modulated
signal, set the lower cutoff frequency ('LOW') slightly below the lower tone and the higher
cutoff frequency above the higher tone of the signal.
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Developer Information

If you would like to develop your own software for the WiNRADiO receiver, full
programming information is available from the WiNRADiO WWW site on the Internet at
http://www.winradio.com. Full API and DDE specifications are outlined including source
and examples that can be downloaded for C++, Delphi and Visual Basic programmers.

If you would like to develop your own DSP applets, development information can be
obtained by e-mailing WiNRADiO at support@winradio.com.
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Declaration Of Conformity

This device, trade name WiNRADiO Communications Receiver, model number WR-3700i-
DSP or WR-3700e complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause
undesired operation.

I have determined and warrant that the above described devices has been shown to comply
with the requirements of the FCC Part 15, by having a device tested at an accredited testing
laboratory. Each unit marked is identical to the device as tested. Compliance assumes no
unauthorized changes will be made to the equipment and it will be maintained and operated
properly. A test report has been generated. A technical file containing the test report will be
maintained for a period of at least 2 years after manufacturing ceases. It is also understood
that characteristics of this equipment will require retesting.

Milan Hudecek

Managing Director

for
Robotron Pty. Ltd.
222 St. Kilda Road
St. Kilda  3182
Australia
+61 3 9525 5300


